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Goal

The goal of this exercise is to serve as an introduction to Spatial Analysis with ArcGlIS.
Objectives

e Use ArcGIS.com services to access and extract elevation data

e Interpolate data values at points to create a spatial field to use in hydrologic calculations. Use
this to calculate watershed area average precipitation

e Use raster data and raster calculator functionality to calculate watershed attributes such as
mean elevation, mean annual precipitation and runoff ratio.

Computer and Data Requirements

To carry out this exercise, you need to have a computer, which runs ArcGIS Pro. The necessary data are
provided in the accompanying zip file, SpatialAnalysisData.zip.

Overview

The purpose of this part of the exercise is to calculate average watershed elevation for subwatersheds
of the Little Bear-Logan subbasin, and to calculate average precipitation over each of these
subwatersheds using different interpolation methods. Average precipitation is then converted to a
volume of precipitation and compared to runoff volumes using a runoff ratio. This provides an insight
into the annual water balance of these watersheds, namely what fraction of precipitation is streamflow
and what fraction is lost to evapotranspiration and other losses such as infiltration and groundwater
recharge.

Data
The following data is provided in the SpatialAnalysisData.zip file:
BasemapExercise.gdb file Geodatabase from BasemapExercise.

4 : is
£y Basemapbxercise.gdb

4 [0 LittleBearLogan

Flowlines

Gages

Subwatersheds

B & [ @

Watershed



LittleBearLoganAnnPrecip.csv. Sites in and around Little Bear Logan Watershed where precipitation has
been measured and data is available in the Global Historical Climatology Network (GHCN). T

AssembleGHCNData.R, monthprecip.csv, monthdaycount.csv. R script and intermediate files used in
preparing the data as described in Appendix. You only need to use these if you want to apply or adapt
this approach to another area or look into the data more deeply.

1. Loading the Data
Open ArcGIS Pro and create a new Map project, SpatialAnalysisExercise
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Copy the file SpatialAnalysisData.zip into the project folder created and unzip it.

Click Connections in the Insert tab and select Add Database to add the BasemapExercise.gdb to the
project. This is another way to associate a Geodatabase with a project.
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In the Catalog pane Expand BasemapExercise.gdb to see
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Right click on the LittleBearLogan feature dataset and “Add To Current Map”.
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You should obtain a map with all these features added
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Add data to the active map.

. Note | changed the symbology a bit.
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If you right-click on one these feature classes in the map legend, select Properties and Source and scroll
down until you see Spatial Reference at the bottom of the layer properties, you’ll see that they have the
NAD 1983 UTM Zone 12N coordinate system. You should also see that the Linear Unit is meters.
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If you move the cursor around on the map, you may see that the coordinates at the bottom are in also
in meters. When the data was added to the Map, its properties switched to that of the data being
added.

Go to https://livingatlas.arcgis.com/ and search for 'elevation'. You should see that one of the first
entries is 'Ground Surface Elevation 30 m' and if you read about this you see that this is 30m raster data
extracted from the USGS's National Elevation Dataset. We will use this DEM in this exercise, but loading
it directly from ArcPro.
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And among the options presented, select Living Atlas. In the Search Portal: Living Atlas type in
elevation and among the options presented, select Ground Surface Elevation 30 m, the DEM identified

in the web search.
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Click OK. You should see a gray “Ground Surface Elevation — 30 m” layer appear on the map.


https://livingatlas.arcgis.com/

This data could also have been downloaded from the National Map viewer,
http://viewer.nationalmap.gov/viewer/, although the process is a bit more tedious. Here we are saving
time taking advantage of the Living Atlas data services.

Your map should look similar to the following:

Save your Project document if you have not already.

Let's export data from this DEM to have a local copy to work with. First we need to define the area that
we want to work with. Let's pick an area that has a 2000 m buffer around the basin.

In the Geoprocessing Panel, use the search box to search on "buffer" and select the Buffer (Analysis)
tool.


http://viewer.nationalmap.gov/viewer/
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Set the inputs as follows and Run the tool.
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Note that | saved the result in the BasemapExercise.gdb LittleBearLogan feature dataset.

The result should be a polygon that is 2000 m larger around the edge of the basin. If necessary, use the
Symbology tool to change the Buffer symbology to an Outline and then you can see the other feature
classes underneath it.



Feature Layer SpatialAnalysisExercise - Map - ArcGIS Pro

e e

oo | st nshe viewlcan inwosy.shuis [
i oo L EA 4 B0 (9 [dy [ Dasbes o [y Greee B | El
¥ e ag 08 K B H Lo , O ]
C % View Unplaced
i o Gasmmap Add Add | St Seectty Sesctly : o | Dot
copy Pt | il ep B i S e Omoes & i

Contents

T [search 5]
=0/ He&
Drawing Order
4[] Map
ol
®
A
T

4[7] Subwatersheds
4[7] Watershed
4[7] Ground Surface Elevation - 30m
Value
8700
450
Topographic

440, 17381E 4,664,513.28N m v

1:348,846 BB

2 - X

& David (Utah State Universit) = [

~ | Geoprocessing x
@® Buffer @
2

Parameters Environments

X

1|2 Catolog | Geoprocessi.. | Symbolo... Element Export Ras... Label Cla.

Use the search box to search on "clip" and select the Clip Raster (Data Management) tool. This tool was

chosen because one of its allowable inputs is an image service.
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Set the inputs as follows (setting the output to go into SpatialAnalysisExercise.gdb) and Run the tool.
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You should have a raster layer added to your ArcMap with a local subset from the DEM, that has the
extent of WatershedBuffer and is easier to symbolize. Turn off the Ground Surface Elevation layers to
see this display.
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Note the skew appearance of the DEM Ibldem just extracted. If you examine the Layer Properties for
Source ->Raster Information for this you will see that it has a cell size of 30.92 m and in Spatial
Reference North America Albers Equal Area Conic coordinate system. This is the resolution and
coordinate system of the data as obtained from the ArcGIS elevation image service. This coordinate
system is appropriate for display for all of North America and is skewed at the longitude of our area.

Let’s add precipitation gages.

Select Add data and add LittleBearLoganAnnPrecip.csv.

Use Display XY Data on the table added to open the XY Table to Point tool and save the output feature

class as PrecipGages in the LittleBearLogan feature dataset.
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This should add precipitation gages to the map. Symbolize them as you like.

Walad Caty
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2. Projecting the DEM

It is desirable to work with data in consistent coordinate systems. Let's project this DEM into the same
projection as the LittleBearLogan Feature dataset (as we noted above the DEM from the web service
was in a different coordinate system). Open the Toolboxes and open the tool Data Management Tools
- Projections and Transformations = Raster = Project Raster. If you find this tool hard to locate,

4 .o Projections and Transformations
4 £ Raster
“. Flip

Mirror

Project Raster

you can also search for it:

Geoprocessing - n
'::{'..:' project raster x - | =

Search Results (82)

*.. Project Raster (Dztz WManagement Took

Set the inputs as follows to produce a projected raster Ibldemproj in SpatialAnalysisExercise.gdb
geodatabase with 30m cells and the NAD 1983 UTM Zone 12 coordinate system used for the basemap.
Note that the NAD 1983 UTM Zone 12 coordinate system is most easily set by clicking next to Output
Coordinate System and selecting from existing Layers on the map.
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Coordinate System

Select the Coordinate System to view the available options.

Current XY Details Current Z
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NAD 1983 UTM Zone 12N
[ é—?’ WGS 1984 Web Mercator Auxiliary Sphere
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The result should appear similar to:

The spatial information about Ibldemproj can be found by right clicking on the ProjDEM layer, then
clicking on Properties = Source = Raster Information, and Statistics
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Layer Properties: Ibldemproj x

General

v Raster Information -
Metaclats Columns 2929
Source Rows 3344
Elevation Mumber of Bands 1
Display Cell Size X 30
Cache Cell Size ¥ 30
Joins Uncompressed Size 37.36 MB
Relates Format FGDER
Source Type Elevation
Pixel Type floating point
Pixel Depth 32 Bit

MaoData Value

Colarmap absent
Pyramids level: 5, resampling: Nearest Neighbar
Compression LZFT

Mensuration Capabilities Basic

» Band Metadata

v Statistics

Build Parameters: skipped columns: 1, rows: 1, ignored value(s):

Band Mame Minimum Maximum Mean 5td. Deviation
Band_1 1281.78771972¢ | 303608203125 | 1913643196447 | 422.490933587¢
r
| QK || Cancel |

To turn in: The number of columns and rows in the projected DEM. The cell size of the projected DEM.

The minimum and maximum elevations in the projected DEM.

3. Exploring the DEM
Change the symbology of the Ibldemproj layer.

=S W) Uy @

Primary symbology

Drawing Order [seretch

Band
4[] WatershedBuffer

= WiarE e
4[] Subwatersheds
4[] Watershed
O

4[] bldemproj 3

&

Value

Label

Gamma

Value
™ 3036.08
-

Statistics.
. 28170
4[] Ibldem
Value
303827

Min
Max

Mean

1281.72

std. dev

Color scheme

Stretch type

Band_1

| . E 4 . -

1281.79 3035:&‘
1281.79 303608,
Fr— ]

Statistics | Mask |

| Dataser

| options v‘

[rzsi 787973 |
[zoss0m03125 |

[noreeaztonts |
[422.49008359 |

To explore the highest elevation areas in your DEM select Spatial Analyst Tools > Map Algebra >

Raster Calculator.
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‘ Spatial Analyst Tools
£- Conditional
=¥ Density
£ Distance
& Extraction
£ Generalization
£ Groundwater
=¥ Hydrology
= Interpolation
£+ Local

a & Map Algebra

* Raster Calculator

Double click on the Ibldemproj layer with the DEM for this area. Click on the greater than “>"” symbol
and select a number less than the maximum elevation. This arithmetic raster operation will select all
cells with values above the defined threshold. In the example below a threshold of 3000 m was used.

Geoprocessing » A x
© Raster Calculator )
Parameters Environments .*;p;

Map Algebra expression

Rasters Tools
Ibldermnproj == -
Ibldem = I
Ground Surface Elevation - 30m £
=
-

"lbldemproj"™ > 3288

A EE| |

Output raster

Ry

demgt3000

A new layer appears on your map. The majority of the map (brown color in the figure below) has a 0
value representing false (values below the threshold), and the purple region has a value of 1
representing true (elevations higher than 3000 meters). If necessary, change the symbology of the
resulting map display so that you can see high elevation areas more clearly and zoom in on them.
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]

4(7] demgt3000

Value
Mo
M
4[] Ibldemproj

Value

P 3036.08
-

. 1231.79

Use the raster calculator again (with elevation 3030 meter threshold) and the explore tool to identify
the grid cell of maximum elevation in Ibldemproj. Take a screen shot similar to the below and indicate

the grid cell with the highest elevation

4[] demgt3000
Value
o
[

4 [/] Ibldempraj
Value

= 3036.08
-

- 128179
4[] Ibldem

Value
3038.27

1281.72
4[] Ground Surface Elevation - 30m

Value

-

Highest point in area

Elevation XXX m

Note that the above label was placed on the screen shot using a word processor. This is a bit easier than

fiddling with labels in ArcGIS.

To turn in: A screen shot showing the location of the highest elevation value in the Little Bear Logan

DEM.

4. Contours and Hillshade

Contours are a useful way to visualize topography. Select Spatial Analyst Tools = Surface = Contour.

Select the inputs as follows, with a 10m contour interval:
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Geoprocessing X
®© Contour @
Parameters Environments @
Input raster
| Ibldemproj "| ~]
Cutput feature class
| Contours |
Contour interval | 5|]|
Base contour | U|
Z factor | 1 |
Contour type
Contour '|
Maximum vertices per feature | |

A layer is generated with the topographic contours for Little Bear Logan area. Notice the big difference
in Terrain Relief in Cache valley to the west and Bear River Range to the east.
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Another option to provide a nice visualization of topography is Hillshading.

Select Spatial Analyst Tools —> Surface - Hillshade and set the factor Z to a higher value to get a
dramatic effect and leave the other parameters at their defaults (the following hillshade is produced
with a Z factor of 10). Click OK. You should see an illuminated hillshaded view of the topography.

Geoprocessing v x
® Hillshade @

Parameters Environments 7

Input raster
Ibldemproj -

Output raster
Hillshade

Azimuth 315

Altitude 45
|:| Model shadows
7 factor 1
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To turn in: A layout with a depiction of topography either with elevation, contour or hillshade in nice
colors. Include the streams from NHDPlus and watershed and sub-watersheds from the
BasemapExercise.gdb LittleBearLogan feature dataset.

5. Zonal Average Calculations

In hydrology it is often necessary to obtain average properties over watersheds or subwatersheds. The
Zonal functions in Spatial Analyst are useful for this purpose. Let’s do this at the HUC10 watershed
scale.

Locate the Dissolve Geoprocessing tool and set the inputs as follows

Geoprocessing > B X
P - T
&) Dissolve +
Parameters Environments @

Input Features
Subwatersheds - i

Output Feature Class
asemapkxercise.gdbtLittleBearLogan\huc1lwatersheds

- - !
Dissolve Field(s]) (~)

HUC10 v

Statistics Field(s)
Field nivjn Statistic Type

- -

Create multipart features
L] Unsplit lines

The resulting feature class has 4 features

B huclOwatersheds X
Field: ﬁﬂxdd EDEIE'EE ECalculate Selection: .%‘" Swi

4 OBIECTID | Shape = HUC10 Shape_Length = Shape_Area
I‘I Polygon | 16010203071 | 143516329307 |562295332,404097

2 Polygon| 1601020302 | 167937.734998 742766372.217343
3 Polygon| 1601020303 | 172341.610482 | 646088951.880712
4 Polygon 1601020304 | 115612.695643 337013525.957088
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Select Spatial Analyst Tools = Zonal = Zonal Statistics as Table. Set the inputs as follows:
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Geoprocessing

€ Zonal Statistics as Table

Parameters Environments

Input raster or feature zone data

huc1Owatersheds
Zone field

HUC1D

Input value raster
Ibldemproj

Cutput table
roneelev

Ignore MoData in calculations

Statistics type
All

|'-::|'|

Click OK. A table with zonal statistics is evaluated and added to the map (at the bottom of the map

display). Right-click to open the table.

A huclOwatersheds FH zoneeley X

Field: ﬁﬁ«dd EDEIete ECaIculate

4 OBJECTID [ HUCTD

|1 1601020301
2 1601020302
3 1601020303
4 1601020304

COUNT

624730
825283
717908
374475

AREA
562302000
742754700
646117200
337027500

Selection:

MIMN
1417584106
1362.995483
1344.411987
1342147949

52 Switch

MAX
2868.670893

2820.20874
3027472
2849.236084

RAMNGE
1451.086792
1457.213257
1683.062134
1507.088135

MEAN
1988.630832

2147.82101
2232123414
1533.967219

STD
316.915465
277.664036
367.636035
276.361859

sumM
1242456771.074463
1772560166.357666
1602459255.904297

574432374,510498

This contains statistics of the value raster, in this case elevation from Ibldemproj over the zones defined
by the polygon feature class huclOwatersheds. The HUC10 field in this zone table may be used to join
these values with attributes of the huclOwatersheds feature class.
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Right click on huclOwatersheds and select Joins and Relates = Add Join.

®

P huclOwatersheds

]

Et

4 [ ] Watershed =
4 [ ] Subwatersheds EH

L]

4 [ | Contours

4 [ | Flowlines

WatershedBuffer

¥
—

¥’ |

|
Copy

Remove

Attribute Table

Design L

Create Chart k

Mew Report

Joins and Relates r [E Add Jein ]

Select HUC10 as the field in this layer (hucl0watersheds) that the join will be based on, zoneelev as the
table to join to this layer, and HUC10 again as the field in the table to base the join on.

Geoprocessing

(€) Add Join

Parameters Environments

Layer Mame or Table View

hucllwatersheds

i, Input Join Field
HUC10

loin Table

zoneeley

Output Join Field
HUCIO

Keep All Target Features

Note the warning, which states: “The join field HUC10 in the join table hucl0watersheds is not indexed.
To improve performance, we recommend that an index be created for the join field in the join table.”

This warning can be ignored for this particular dataset because this table is sufficiently small, so the
presence of indices to speed up the data queries does not make any noticeable difference.

22



Open the huclOwatersheds attribute table and scroll across. You'll see the statistics have been added to
the attributes that this feature class already held.

FH huclOwatersheds % R zoneelev

Field: ;ﬁ Add @ Delete @ Calculate | Selection: 155“ Switch

4 OBJECTID | Shape = HUC10 Shape Length Shape Area OBJECTID | HUC10 COUNT | AREA MIN MAX RANGE MEAN STD SUM
|1 Polygen| 1601020301 | 143516.328307 | 562285332.404097 11601020301 | 624780 |562302000 |1417.584106 |2868.670898 |1451.086792 |1988.630832 316915465 |1242456771.074463
2 Polygen 1601020302 | 167937.734098 742766372.217383 2 11601020302 | 825283 | 742754700 |1362.995483 | 2820.20874 |1457.213257 | 2147.82101 277.664036 |1772560166.357666
3 Polygen| 1601020303 | 172341.610482 | 646082951.880712 311601020303 | 717908 |646117200 |1344.411987 (3027474121 |1683.062134 |2232.123414 |367.636035 |1602459255.904297
4 Polygon 1601020304 | 115612.695643 337013525.957088 4 11601020304 = 374475 337027500 |1342.147949 2849.236084 1507.088135 |1533.967219 276361859 = 574432374.510498

Click to add new row.

In the Geoprocessing panel, select Table to Excel and specify Subwatershed as the input Table, and
SubwatershedStats as output Excel file.

Geoprocessing -~ # ! Geoprocessing v 1 x
(©) | table to excel x |2 (© Table To Excel &)
Search Results (66)
EJ Table To Excel (Conversion Tooks Parameters Environments u‘;:':
Input Table
hucllwatersheds -

Output Excel File (xls or xlsx)

sy ArcGISWork Spatial AnalysisExerciselhuc1 Ostats.xlsx
|:| Use field alias as colurmn header

[ | Use domain and subtype description

If you open up the resulting huc10Ostats Excel file you’ll see the descriptive statistics there for these
huc10 watersheds.

Determine the mean elevation and elevation range of each hucl0 watersheds in the Little Bear Logan
subbasin.

To turn in: A table giving the HUC10, mean elevation, and elevation range for each watershed in the
hucl0 watersheds feature class. Which watershed has the highest mean elevation? Which watershed
has the largest elevation range?

6. Calculation of Area Average Precipitation using Thiessen Polygons

Now to do something really useful. We will calculate the area average mean annual precipitation over
the watershed using Thiessen polygons. Thiessen polygons associate each point in a watershed with the
nearest raingage. Let’s do this for watersheds draining to each stream gage.

In the geoprocessing panel locate the Watershed tool in Ready to Use Tools under Portal
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Geoprocessing

Find Tools L - ®

Favorites Toolboxes

4 Ready To Use Tools

k {-. Elevation

4 & Hydrology

o ream
* Watershed

b &q Network Analysis

Set input points as Gages and Data Source Resolution FINEST.

Geoprocessing > 1 x

© Watershed &>

Parameters Environments @
Input Points ]
Gages J *| i

Point |dentification Field

Snap Distance

Snap Distance Units

Meters *l

Data Source Resolution ]

FINEST |
Generalize Watershed Polygons

Return Snapped Points

Click Run. Three watersheds should be delineated.
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It may be that you are not able to do this due to this function using ESRI cloud credits that may not have
been assigned to your account. You may need to work with your university instructor and ESRI site
license manager to get this capability for your ESRI account.

Alternatively, you may do this for the HUC10 watersheds, instead of delineated watersheds.

Right Click on OutputWatershed from the Watershed delineation and select Data -> Export Features to
open the Feature Class to Feature Class tool. Name the result gagewatersheds and put it in the
LittleBearLogan feature dataset.

Geoprocessing ~ %
'23:—} Feature Class to Feature Class u:}E}
Parameters Environments @

Input Features
Output Watershed M s

Output Location
AnalysisExercise\BasernapExercise.gdbhLittleBearl cgan

Output Feature Class
gagewatersheds

Expression
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Turn on the PrecipGages layer in the map display and open their attribute table. You’ll see an AnnPrecip
attribute which is the mean annual precipitation at each gage in mm.

Field: 3 Add [F3 Delete [E Calculate | Selection: %é Switch
4 OBJECTID | Shape SiteMame SiteCode FullSiteCo Latitude Longitude Elevation d1 d2 nd nm@ annprecip
I‘I Point  BEAR LAKE SP USCOM20487 GHCN:USC00420487 41,8583 | -111.3922 1806.9 |1/1/1989|6/30/2017 | 10407 | 20@ 347.359211
2 Point  BRIGHAM CITY WAS... | USC00420928 GHCN:USC00420928 41,5239 | -112.0436 1289.3 |1/1/1974|6/30/2017 | 15886 | 32§ 399.520136
3 Point  CUTLER DAM USCOM21918 GHCN:USC00421918 41.8328 | -112.0558 1307.6 |1/1/1980|6/30/2017 | 13685 | 32)§ 427.072792
4 Point  HUMNTSVILLE MONAS... USC00424135 GHCM:USC00424135 41.2403 | -111.7131 1566.7 |1/1/1976/12/31/2013| 13870 | 27§ |551.386765
5 Point  LAKETOWN USCO0424856 GHCN:USC00424836 41.825 | -111.3208 1822.7 [1/1/1900|6/30/2017 (42914 | 32 370.666283
6 Point  LOGAN RADIO KVNU | USC0D425182 GHCN:USC00425182 41.735 | -111.8564 1364 |1/1/1956 6/30/2017 22461 = 324 426.836983
7 Point  LOGAN UTAH STUNIV |USC0O0425186 GHCN:USC00425186 41,7456 | -111.8033 1460 |1/1/1893 6/30/2017 | 45470 | 31 493.154006

Select the tool Analysis Tools = Proximity = Create Thiessen Polygons

a Analysis Tools
£ Extract
& Overlay
£ Pairwise Overlay
4 & Proximity

“. Buffer

| Create Thiessen Polygons |

Specify PrecipGages as the Input Features. Save the output feature class in the LittleBearLogan feature
dataset and indicate that ALL fields should be output. By saving to the LittleBearLogan feature dataset
you ensure that the Thiessen polygon feature class inherits the spatial reference information from this
feature dataset, keeping all your work in a consistent spatial reference. Click OK. It's really important
that you select “All” here to carry the attributes of the Precipitation stations to the polygons associated
with them.

Geoprocessing » A x
© Create Thiessen Polygons *®
Parameters Environments @

Input Features

PrecipGages - P
Output Feature Class

thiessenpoly
Output Fields

All fields -
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Switch to Environments and for Extent select Watershed

Geoprocessing > A x
© Create Thiessen Polygons *
Nl LA
Parameters Environments ._';p_.

Output Coordinate Systern

Geographic Transformations

'::D Extent Az Specified Below B
P
4= 412486.620 As Specified Below -
Browse....

4| 4579932.6082
Same As layer.

Output XY Domain Output Snapped Points

Cutput M Domain PrecipGages
Output Z Domain i
XY Tolerance Watershed

THIESSENPOTY

This is important to avoid the polygons not completely covering the watersheds being used.

The result is a Thiessen polygon feature class. This tessellates the landscape into regions that are closer

to a particular gage than to any other.
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Here is what your attribute table should look like for thiessen polygons. If it doesn’t have all these
attributes at the right hand end, delete the result you just computed and do it over with the ALL option
selected to make sure you transfer all the attributes from the gages to the polygons.

Field: [ Add [F Delete [ Calculate | Selection: 2 Switch

4 OBJECTID | Shape  Shape_Length Shape_Area Input_FID  SiteName SiteCode FullSiteCo Latitude | Longitude | Elevation | d1 d2 nd  nmo annprecip
|1 Polygon 40000.767462 = 93490066.044634 16 |Ben Lomond Peak  UISS0D11HOES GHCR:USSO01THOBS 4138 | 11184 | 24384 17171978 6/30/2017 14425 | 330 |1458.708777
2 Polygon B80658.171802 378780145.855697 23 |Monte Cristo USS0011HS7S GHCR:USSO01THSTS 4147 1115 2731 1/1/1978 6/30/2017 14425 | 327 | 993.26627
3 Polygon 71337.626833 342110071.543406 18 |Little Bear USS0011H255 GHCR:USSO0TTH255 4141 11183 | 19946 1/1/1078 6/30/2017 14425 | 327 | 875.193497
4 Polygon 32124.462381  39419189.51191 19 Ben Lomond Tril USS0011H305 GHCR:USSO011H30S 4138 | -111.92 | 17767 1/1/1980 6/30/2017 13605 | 327 |1050.625324
5 Polygon §2640.243508 198295801.291659 2 |BRIGHAM CITY WAS... USC00420028 GHCR:USCO0420028 | 415230 | -112.0436 | 1280.3 |1/1/1974|6/30/2017 15886 | 323 | 390.520186
6 Polygon 67870.400471 207292640.501138 22 |Dry Bread Pond USS0011H355 GHCR:USSO011HS5S 4141 11154 | 25450 1/1/1978 6/30/2017 14425 | 330 | 783.452703
7 Polygon T7926.567362 323100363.206263 20 |Tony Grove Lake USS0011H365 GHCR:USSO0TTH365 419 | -111.63 | 25820 1/1/1978)6/30/2017 14425 | 327 1222911655

If you rearrange the map display you can get a map looking something like the below. What we’re going
to do is to find the area of each thiessen polygon that overlays each gagewatershed. This is done using
the Intersect function, one of the most powerful functions of spatial analysis.
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To average precipitation values in these polygons over the subwatersheds we need to intersect the
thiessen polygons with the gage watersheds and compute area weighted averages for each

subwatershed. The following calculations achieve this.
Use the search window to locate the Intersect (Analysis) tool and set the inputs as follows

Geoprocessing v X
® Intersect @
@

Parameters Environments

Input Features 'i"}:' Ranks

gagewatersheds

thiessenpoly

Output Feature Class
napExercise.gdb\LittleBearLoganithiessen_ws_intersect

Attributes To Join
All attributes

XY Tolerance
Meters

Output Type
Same as input
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Following is the result, the thiessen_ws_intersect polygons symbolized with SiteCode as the Unique
Value field — this is the identifying code of the rain gage in the Global Historical Climate Network

(GHCN).
S
T o
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7 R o
A o/ |
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]

If you open the ThiessenSublntersect attributed table you will see that from the 3 subwatersheds there
are now 14 polygons, each contributing to part of a subwatershed and associated with a single rain
gage. Let Px denote the precipitation associated with each rain gage and Ai the area of intersected
polygon associated with rain gage k and subwatershed i. Then the area weighted precipitation

associated with each subwatershed is
_ kAP

p, = 2k k
Yk A

Open the attribute table for the intersected thiessen polygons and add a new field to the table, APProd
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E zoneelev b

Field: Eﬁkdd EDelete ECalculate Selecl

ORI T~ mmm e
"'|1— Add Field

Add a new field in this table.

2

Double-click on the greyed-out “Data Type” column, where it says Long, and change the Data Type of
APProd to Float. If you don’t change this data type, your calculations will fail on a datatype mismatch
error.

B huclOwatersheds B zoneelev = Gages iz PrecipGages iz thiessenpoly B2 thiessen_ws_intersect

Current Layer thiessen_ws_intersect -
4 [ Visible [M]Read Only Field Mame Alias short [ Highlight Mumber Format D
lono
7 d2 d2
O Float u
7 nd nd Mumeric
[] Deuble
|:| nmo nmao Date |:| Mumeric
] annprecip annprecip Text [ Mumeric
Blob
] ] Shape_Length Shape_Length D_ Murmeric
Guid
ui
7 7 — Shape_Area Mumeric
[v] ] ¥ P Raster
0 APProd Long |* L]

Make sure to save your changes using the save button in the Fields tab at the top of the screen.

FIELDS INSERT AMALYSIS VIEW SHARE

@ Filter Name: @ E’

Filter Domain:

Domains Subtypes Newl| Save
Field|
Design Filter Changes

Go back to the thiessen_sub_intersect polygon attribute table and right-click on the header of APProd,
selecting “Calculate Field”.

8 thiessen_sub_intersect X %Fie\ds: thiessen_sub_intersect -

Field: ;ﬁ Mew E Delete E Calculate | Selection: f& Switch =
_aiessenpoly  Input FID  COOPID  stname latdd longdd  ELEVATION ELEM Myr AnnPrecip_in  Shape_Length Shape_Area APProd |
_—
| 5 2 410429 AUSTIN-BERGSTRO.. 30183333 -97.683333 1463 TPCP 6 34515 51277.805067 77596679.322343 <Myl z¥ SortAscending
6 32 419815 WIMBERLEY 1 NW 30 -98.066667 253 TPCP 2 4047619  34427.447989  44918977.209083 <Mu| a¥ SortDescending
18 22 415285 LOCKHART 2 5W 29.85 -97.7 1494 TPCP 10 36125 67155210013 16825434346856 <MNu| T Custom Sort..
6 32 419815 WIMBERLEY 1 NW 30 -98.066667 253 TPCP 2 4047619 66821259515 120874333043417 <Mu "
fE Calculate Field
7 E A1R3IKA  SISTFRMNAIF 200R3333 -0R 7331 42R7 TPCP 11 4n 497272 M14 R44RA A33144AR7 AN <N
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Create the expression !annprecip! * !Shape_Area! and click Run.

Geoprocessing >3 X
© Calculate Field @
Parameters Environments @
Input Table
thiessen_ws_intersect - |
Field Mame
| APProd |
Expression Type
| Python 3 |
Expression
Fields T Helpers T
di £ | .conjugate) =
d2 .denominator() I
nd Jdmag()
nma .numerator()
annprecip realf])
Shape_Length .as_integer_ratio()
Shape_Area fromhex()
APProd | | hex(] =
|In5ert‘u‘a|ue5 '| L A

I gl gy
|!annpr‘ecip! * !Shape_ﬂ.r‘ea!| :
]

The result is a new field with the numerator terms for the equation above. Now locate the column Pour
Point ID. These are unique identifiers for each gage watersheds (1, 2, 3 assigned during their creation).
Right click on the header and select Summarize

Calculate Geomnetry

Statistics
[ @ Summarize

BH Gages |m_ f
—— 3= g Fields Summary Table

te | Selection: ﬁ Delete

Create a summary ta

45 | Pour Point IE_D_'_'ES::rlptl the current field. If ai

currently selected, o

1 1 NED 30m|  roys will be calculat
1 1 |MED 30m processed... [300
1 1 |MED 30 processed... |30.0
1 1 |MED 30rn processed... | 30.0
1 1 |MED 30m processed... |30.0
2 2 MED 30m processed... 30.0
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Carefully select the summary statistics you need. | selected the following: Pout Point ID - First,
Shape_Area - Sum, APProd — Sum, and the Pout Point ID Case field. Click Run.

Geoprocessing > X
© Summary Statistics *
Parameters Environments @
Input Table
| thiessen_ws_intersect - |

Output Table
| thieszen_stats |

Statistics Field(s)

Field () Statistic Type
| Pour Point ID -|| First -
| Shape_frea "| Surmn '|
| APProd - -
| |

Case field (&)

| Pour Point ID '|

| T |

Navigate to your output table, and you’ll see that the resulting table gives the numerator and
denominator in the equation above for each subwatershed.

FH huclOwatersheds FH zoneelev = thiessen_stats *

Field: j;_m Add @ Delete @ Calculate | Selection: *EE;. Switch
4 QBJECTID | Pour PointID  FREQUENCY | FIRST_PourPtlD = SUM_Shape_Area SUM_APProd
I 1 1 5 11 517253854.778151 | 404967735808
2 2 5 2 679242847.138664 540768213504
3 3 4 3 | 555011142.085791 | 353897109504
Click to add new row.
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Add a New field GageW_Precip_mm to this table, again as a Float, and Save the result.

B2 huclOwatersheds B zoneelev B thiessen_stats HEEI Fields: thiessen_stats X

Current Layer |thiessen_5tat5 =
4[] Visible  [M] Read Only = Field Name Alias Data Type [ Highlight Murmber Fort
OBJECTID OBJECTID Object 1D ] Murmeric
] PourPtlD Pour Point D Long ] Murneric
] FREQUENCY FREQUEMNCY Long ] MNumeric
|:| FIRST_PourPtiD FIRST_PourPtiD Lang |:| Murmeric
|:| SUM_Shape_Area SUM_Shape_Area |Double |:| Murmeric
] SUM APProd SUM APProd Double ] Mumeric
] GageW_Precip_mm | GageW_Precip_mm]Flcat ] Murneric

Go back to the thiessen_stats table and use Calculate Field to evaluate this as !Sum_APProd! /
ISum_Shape_Area!. Right click on the top of the field to open Calculate Field.

Geoprocessing > X
© Calculate Field ®
Parameters Environments @
Input Table
| thiessen_stats - |
Field Mame
| GageW _Precip_mm '|
Expression Type
| Python 3 - |
Expression
Fields T Helpers T
OBJECTID .conjugate() -
Pour Point (D .denorninator() I
FREQUEMCY Jamag()
FIRST_PourPtlD .numerator()
SUM_Shape_Area real()
SUM_APProd .as_integer_ratio()
GageW_Precip_mm fromhex()
hex() ¥
Insert Values Wl < Y = = =

GageW_Precip_mm =
1SUM_APProd! J 1SUM_Shape_Area!

4

Code Block
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The result is the precipitation in mm for each subwatershed. This is pretty cool! And you can see how
the tools in ArcGIS can give you a spatially area-weighted result that would be more tedious to derive
otherwise.

To turn in: A table giving the Pour Point Identifier, Name, and mean precipitation by the Thiessen
method for each gage watershed. Determine the watershed names from their associated stream gages
Which subwatershed has the highest mean precipitation?

7. Estimate basin average mean annual precipitation using Spatial Interpolation/Surface
fitting

Thiessen polygons were effectively a way of defining a field based on discrete data, by associating with
each point the precipitation at the nearest gage. This is probably the simplest and least sophisticated
form of spatial interpolation. It also does not account for elevation adjustments. ArcGIS provides other
spatial interpolation capabilities in both the Spatial Analyst and Geostatistical Analyst Toolboxes.
Following are the interpolation tools in each.

4 Spatial Analyst Tools 4 Geostatistical Analyst Tools
£ Conditional 4 £ Interpolation
£ Density “.. Diffusion Interpolation With Barriers
£.- Distance “\, EBK Regression Prediction

£ Extraction “.. Empirical Bayesian Kriging

£.- Generalization Global Polynomial Interpolation
£+ Groundwater “., IDwW
=% Hydrology Kernel Interpolation With Barriers
4 Lo Interpolation Lecal Polynomial Interpolation
“. IDW Moving Window Kriging

“.. Kriging Radial Basis Functions

-~

Matural Meighbor
Spline

Topo to Raster

Topo to Raster by File
Trend

We will not, in this exercise, concern ourselves too much with the theory behind each of these methods.
You should however be aware that there is a lot of statistical theory on the subject of interpolation,
which is an active area of research. This theory should be considered before practical use of these
methods.

In preparing this exercise | experimented with Empirical Bayesian Kriging which is reported to be one of
the most advanced of these. | found that it took a very long time to complete, however you are

35



welcome to try it with the following inputs. Use the input points from "PrecipStn" and Z value field as
"AnnPrecip_in". Set the output cell size to 100 m to improve the spatial resolution.

Geoprocessing > x
© Empirical Bayesian Kriging @
Parameters Environments @
Input features
| PrecipGages *| ]
Z value field
| annprecip '|

Output geostatistical layer

Output raster

| emp_bk | [~
Output cell size
100 | e

Data transformation type

|None “’|

Semivariogram model type

| Power “’|

* Additional Model Parameters
* Search Meighborhood Parameters
* Qutput Parameters

Also set extent to watershed to make sure the result covers the area you want.

Following is the result from Empirical Bayesian Kriging

4 [ | WatershedBuffer

4[] emp_bk
VALUE
M = 5081479334
B <574.010419
[ < 625.8434035
< B66.6156019
< 718.4395858
< 784.311072
| < 8680373018
B < 974.4506496
M = 1,109.728395
B 128166333

4[] Hillshade

Value
254

|




Following are inputs for tension Spline interpolation (Spatial Analyst tools). Use the input points from
PrecipGages and Z value field as annprecip, and set the spline type as Tension with parameters as
follows. | reduced the output cell size to 100 m to improve the spatial resolution. The result follows:

Geoprocessing - 3 x
® Spline @®
Parameters Environments @

Input point features

| PrecipGages *| ™
Z value field

| annprecip *|
Cutput raster

| spline | ™
Output cell size

| 100 |
Spline type

Tensicn "|
Weight | 0.1]
Mumber of points | '|E|

» g o o
- B

=
A| spline

VALUE

M : 450.6590578

B < 5315997401
£ 6709424198
= 731.902194
< 8212448737

B < 952.185556

B = 1,144.082294
< 1,425.35082
< 1,837.563721

4 emp_bk
VALUE
M < 5081479334
B = 5740194196
I = 625.8434035
< 666.6156019
< 71843095858
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Now, let’s use Zonal Statistics to compute the average value of the spline precipitation map over each
subwatershed. Select Spatial Analyst Tools > Zonal - Zonal Statistics as Table. Set the inputs as
follows:

Geoprocessing > 4 x
© Zonal Statistics as Table )
Parameters Environments @
Input raster or feature zone data
gagewatersheds - F -
Zone field
Pour Point 1D v

Input value raster

spline

Output table

ronespline
Ignore MoData in calculations
Statistics type

All

Click Run. A table with zonal statistics is created. This contains statistics of the value raster, in this case
mean annual precipitation from Spline over the zones defined by the polygon feature class
ggewatersheds.

B2 huclOwatersheds EE zoneelev E= thiessen_stats B zonespline X
Field: E;ﬁ«dd ﬁDeletE ECalculatE Selection: .tgé Switch

4 OBJECTID | PourPtiD COUNT = AREA MIN MAK RAMNGE MEAN 5TD SUM
|1 1| 51723 |517230000 |306.085571 @ 080.356680 474271118 |7A8.436626 | 76.505703 30745847.627899
2 2 67928 679280000 581.322266 1014800232 433477966 781.416452 |114.541129 53080056.766174
3 3 55523 |555230000 526.560364 1275.653076 749.092712 1010.87846 |232.608714 | 56127004.71031
Click to add new row.
The PourPtID in this table may be used to join it to the attribute table for the gagewatershed feature

class. As for the elevations above this joined statistics table can be exported to Excel for formatting to
prepare your turn in results.

To turn in: A table giving the Pour Pt ID, Name, and mean precipitation by the Tension Spline method for
each gage watershed. Which subwatershed has the highest mean precipitation using a Tension Spline
interpolation?

We will stop here. There are other things that would be interesting to do. | am going to list them for
you to explore, but not make as part of the exercise as this is long already.
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1. Use zonal statistics to determine the elevation of each rain gage. Cross check this against
elevation from GHCN.

2. Develop a relationship between elevation and annual precipitation. We know that precipitation
in this area is orographic, so a relationship is expected.

3. Use the elevation — precipitation relationship to calculate a grid of precipitation estimated from
elevation and average this over watersheds. Compare this to the area average watershed
computed from spline interpolation or thiessen polygons that operate in the horizontal plane.

4. Examine annual steamflow at the stream gages that define watershed outlets. Convert this to
depth (volume / area) and compare to precipitation depth. Streamflow depth/Precipitation
depth is runoff ratio, and tells us the fraction of precipitation that manifests as streamflow.

Summary of Items to be Turned in:

The number of columns and rows in the projected DEM. The cell size of the projected DEM. The
minimum and maximum elevations in the projected DEM.

A screen shot showing the location of the highest elevation value in the Little Bear Logan DEM.

A layout with a depiction of topography either with elevation, contour or hillshade in nice colors.
Include the streams from NHDPIus and watershed and sub-watersheds from the
BasemapExercise.gdb LittleBearLogan feature dataset.

A table giving the HUC10, mean elevation, and elevation range for each watershed in the huc10
watersheds feature class. Which watershed has the highest mean elevation? Which watershed has
the largest elevation range?

A table giving the Pour Point Identifier, Name, and mean precipitation by the Thiessen method for
each gage watershed. Determine the watershed names from their associated stream gages Which
subwatershed has the highest mean precipitation?

A table giving the Pour Pt ID, Name, and mean precipitation by the Tension Spline method for each
gage watershed. Which subwatershed has the highest mean precipitation using a Tension Spline
interpolation?

Appendix.

This appendix describes the use of CUAHSI data services (http://data.cuahsi.org/) and the CUAHSI
WaterML R package (https://www.cuahsi.org/data-models/discovery-and-analysis/) to assemble the
data for this exercise. However there were some difficulties with the WaterML package for the GHCN
service so | used the RNOAA package to actually get the data. The work done in preparing
LittleBearLoganAnnPrecip.csv is detailed in AssembleGHCNData.R.

The steps followed were

1. Install necessary R packages.
2. Get list of CUAHSI data services using GetServices().
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http://data.cuahsi.org/
https://www.cuahsi.org/data-models/discovery-and-analysis/

Identify which service is for the Global Historical Climatology Network. This has server
http://hydroportal.cuahsi.org/ghcn/cuahsi 1 1.asmx?WSDL

Get list of sites from this server GetSites(server)

Output sites to a CSV file, import to ArcGIS to see where they are located.

Use a spatial query to select sites inside and within 20 km of Little Bear River subbasin
boundary.

Read these local sites into R

Use GetSitelnfo() for each of these sites to identify the period of record of precipitation data.
Select only sites with more than 10 years of data

. Use a NOAA data service ncdc() from RNOAA R package to download the data.
. Use R to compute annual average precipitation for sites with sufficient data and write the

results.
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